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Introduction - WorkPace Reports
WorkPace automatically records monitoring data for each individual that uses the software.    Unless 
this feature is turned off (see "System Administrator Mode".      A range of information is logged as a 
daily summary for each day of the year with a total of 12 months information been stored in the user 
file (once the user file is full the oldest monitoring data is simply overwritten ).    The information 
includes the time spent using the keyboard and mouse, the number of keystrokes and mouse clicks, 
the current WorkPace settings, and the number of breaks, micropauses taken and ignored.    All this 
information is automatically logged and stored in the user file (*.usr).    This information can be viewed 
on screen through the System Admin login / User Data or the menu View / User Data (unless this 
has been disabled by the "System Administrator").    To be able to properly analyse this information, 
however, we really need to be able to load it into software packages that are designed for such 
analysis e.g. Microsoft Access, Excel, Crystal Reports.    WorkPace Reports has been designed to 
allow you to do this.

WorkPace reports allows you to access all the user files and extract recorded information and 
monitoring data for specific users, specific parameters and a specific period of time.    For example, 
you might want to compare the daily keystroke totals for 5 people over the last 3 months.    Using Excel 
or Crystal Reports (and similar packages e.g. Lotus 123, Quicken) you can then perform more detailed 
analysis of the data e.g. calculate weekly and monthly totals, averages, maximum's and minimums as 
well as plotting graphs.



Password
You can set a password for WorkPace Reports to prevent unauthorized users from gaining access to 
other people's recorded user statistics.

1. Choose File / Set Password 

2. Enter your choice of password

Note:  Passwords are case sensitive. 

The default when WorkPace Reports is first installed is to have no password.    Once you have set 
your password you must ensure that you do not forget it.    If you forget the password you will need to 
reinstall WorkPace Reports to reset it.

Note: The WorkPace reports password is quite separate from the WorkPace system administrator 
password.    You can, of course, choose to use the same password for both (however, changing the 
password for one package will not change the password for the other)



Multiple User, Single Statistic Report
This option allows you to export and examine a single WorkPace statistic for multiple users.    For 
example you may wish to create a report showing the total computer usage time for a group of people. 
To create such a report:

1. Go to the Main window of WorkPace Reports

2. Select option 1

3. Using the Drive and Directory boxes go to the directory where WorkPace user files are 
stored.    This would normally be C:\WorkPace\User if WorkPace is installed locally, or the 
central user directory on a network.    Whenever you go to a directory where user files are 
stored, the filenames will be displayed in the User List box.    If you select one of these 
filenames, more detailed information is given in the top right area of the window.      You may 
also select a directory with user files you have visited before using File option from the menu. 
You may sort the users by different categories using the Options menu

4. Once there are names listed in the User List box, you may choose any number of users to 
report on by using the left and right arrow buttons to add or remove users to or from the 
Selected Users List

5. Select a reporting period 

6. Select a Statistic to report on 

7. Click the Create Report button.    A save box will appear

8. Type in a file name to save the report data under, e.g. report.txt and click Save

9. This data is in a suitable format for importing into most database and graphing packages.    
See instructions for importing the data into Microsoft Excel, Access, and Word.



Selecting a Statistic for Multiple User, Single Statistic Report

This explaination applies to the Multiple User Single Statistic report.    The statistics have been divided 
into 3 categories.    These are:

1. Usage Statistics - these include the users' time spent on the computer, numbers of mouse 
clicks, keys pressed etc

2. Break Statistics - these are the number of, and types of breaks taken by users

3. User Settings -    reports on the WorkPace settings for the user

To select a statistic:

1. Select one of the above classes from the Category pulldown list

2. Select a statistic from the Statistic pulldown list



Single User, Multiple Statistics Report
This option allows you to export and examine multiple WorkPace statistics for a particular person.    
For example, you may wish to print out statistics on one person's mouse usage, keystroke totals, and 
the number of breaks they have taken. To create such a report:

1. Go to the Main window of WorkPace Reports

2. Select option 2

3. Using the Drive and Directory boxes go to the directory where WorkPace user files are 
stored.    This would normally be C:\WorkPace\User if WorkPace is installed locally, or the 
central user directory on a network.    Whenever you go to a directory where user files are 
stored, the filenames will be displayed in the User List box.    If you select one of these 
filenames, more detailed information is given in the top right area of the window.      You may 
also select a directory with user files you have visited before using File option from the menu. 
You may sort the users by different categories using the Options menu

4. Once there are names listed in the User List box, highlight the user you wish to generate a 
report for

5. Select a reporting period 

6. Select the statistics you wish to report on 

7. Click the Create Report button.    A save box will appear

8. Type in a file name to save the report data under, e.g. report.txt, and click Save

9. This data is in a suitable format for importing into most database and graphing packages.    
See instructions for importing the data into Microsoft Excel, Access, and Word.



Selecting Multiple Statistics

This help applies to the Single User, Multiple Statistics report.    You may select multiple statistics from 
the Statistics list box by holding down the CTRL key on the keyboard (bottom left key) and clicking 
the entries in the list.    You may also deselect entries this way.    By clicking on the Usage button, 
Break button, or Settings button you can quickly select or deselect the entire corresponding category 
of entries.



Selecting a Reporting Period
You may select the reporting period in three different ways:

1. Manually: Go to the Reporting Period area of the window and select the period manually by 
clicking on the day, month or year of the date you wish to change and using the up/down 
arrows (or the keyboard)

2. Select by Month: From the menu select the month and year you wish to generate a report on, 
and the Reporting Period area is automatically filled in for you with the beginning and the end 
of the month you selected

3. Select by Year: From the menu select the year you wish to generate a report on, and the 
Reporting Period area is automatically filled in for you with the beginning and the end of the 
year you selected



Importing Data into other packages
The report data files produced by WorkPace Reports can be imported into most data analysis 
packages.    Included here we provide step-by-step instructions for importing data into Microsoft Excel, 
Word, and Access.



Importing Data into Excel

Once you have generated either a Single User, Multiple Statistics Report or a Multiple User, Single 
Statistic Report, you may view the data by importing it into an Excel Worksheet :

1. Start Excel

2. From File menu, select Open.    A file open window now appears

3. From the Files of Type pulldown list select All Files (*.*)

4. Navigate the file structure until you find the name of the file you saved the report under

5. Double click on the file name

6. You will now be taken to the Text Import Wizard.    Click Finish



Importing Data into Word

Once you have generated either a Single User, Multiple Statistics Report or a Multiple User, Single 
Statistic Report, you may import the data into a Word table:

1. Start Word 

2. From the Insert    menu, select File.    A file open window now appears

3. From the Files of Type pulldown list select All Files (*.*)

4. Navigate the file structure until you find the name of the file you saved the report under

5. Double click on the file name

6. Select/highlight the imported report text

7. Choose Table / Convert Text to Table

8. Press OK



Importing Data into Access

Once you have generated either a Single User, Multiple Statistics Report or a Multiple User, Single 
Statistic Report, you may view the data by importing it into an Excel Worksheet :

1. Start Access

2. From File menu, select Get External Data / Import.    A file open window now appears

3. From the Files of Type pulldown list select Text Files

4. Navigate the file structure until you find the name of the file you saved the report under

5. Double click on the file name

6. You will now be taken to the Import Text Wizard.

7.  Click Next

8. Tick the check box First Row Contains Field Names.    Click Next.

9. Choose whether to store this information in a New Table or an Existing Table

10.Click Next

11.Click Next

12.Type in name of report table



The WorkPace Reports Data Format
The output report file that WorkPace Reports produces is a text file containing rows and columns of 
information.

WorkPace Reports exports the data you select into a text file containing a table of the information.    
The format of this table is as follows.

The rows are consecutive days with the first column showing the date for each row.    Even though 
data may not exist for every day in the chosen period (i.e. if the computer was not used for several 
days) all dates in the period are shown in the report.    For those days on which no data was recorded 
the data field is left blank -- equivalent to a NULL value.    Note that a blank/NULL value is quite 
different to a zero value.    A zero value might, for example, mean that although the person was using 
the computer no rest breaks were taken, whereas a blank/NULL means that the person did not use the 
computer that day at all.    This difference is important when calculating averages and counting days 
worked e.g. if we want the average time worked per day we are normally only interested in averaging 
over the days actually worked, not the total number of days in the month.    As most people do not work 
during the weekend then data will likely only be recorded for around 20 - 22 days out of each month.
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Export format options

Depending upon what software package you are going to use for further analysis of the WorkPace 
uses statistics you may need to adjust the export format for WorkPace Reports.    Many packages such 
as Excel and Access can take data in many formats.    However, other packages may be more 
restrictive and, for example, may require that Field Delimiters be commas, Null values be displayed as 
"", Boolean fields as True/False and any text be surrounded by quotes.      If you are having problems 
importing the data you can try changing some of the export format options.

Field Delimiter
Used as the separator between different fields.

Options
Tab*
Comma
Semicolon
Space

*Default

Text Qualifier
Used to surround any text fields.

Options
Double quote* "
Single quote '
{None}

*Default

Date Format
The exact form for the Short, Medium, and Long date formats is determined by your Regional settings 
(see Windows Control Panel).

Format Example
Medium Date* 24-Sep-98
Long Date Thursday, 24 September 1998
Short Date 24/09/98
dd mmm yyyy 24 Sep 1998
dd/mm/yyyy 24/09/1998
mm/dd/yyyy 09/24/1998

*Default

Time Format
The exact form for the Short, Medium, and Long time formats is determined by your Regional settings 
(see Windows Control Panel).

Format Example
Medium Time* 08:23 PM
Long Time 20:23:34
Short Time 20:23
hh:mm:ss AM/PM 08:23:34 PM
hh:mm:ss 24hr 20:23:34
hh:mm AM/PM 08:23 PM
hh:mm 24hr 20:23



*Default

Boolean
False True
0* -1*

0 1
F T
False True
No Yes
N Y
Off On

*Default

Null Field
A Null field is any field/parameter for which no information was recorded.    This would occur if, for 
example, the person did not use the computer on a particular day.    Note that a Null value is not the 
same as a zero value. *Default

Options
{none}* (i.e. blank)
NULL
0
-

Data separators

Each row in the report text file is separated by Carriage Return/New Line.    Each column/field is 
separated by either a ',' 'TAB' ':' or 'SPACE' character.    The default is a 'TAB' character.    The column 
separator can be changed under the menu Options / Export Format.    Text fields (dates or names) 
are delimited by either single or double quotes (or no delimiter) -- see Options / Export Format / Text 
Qualifier.



Multiple users, single statistic report

For this report each column contains data for a different user, with the column title being the user's 
name.    The first columm shows the name of the parameter being reported on.    An example is shown 
below.

"Micropauses ignored" "John" "Mary" "Bill" "Paul"

"1/3/98" 13 27 0 2

"2/3/98" 5 10 0 19

"3/3/98" 7

"4/3/98" 9

"5/3/98" 12 10 0 21

Note here that the 3/3/98 and 4/3/98 were the weekend and in this case John was the only person 
working over the weekend, meaning that the data fields are blank for everyone else who did not work.

Note that this format is primarily intended for importing into other packages, such as Excel, Word, and 
Access.



Multiple statistics, single user

This report is for a single user, and each column contains a different parameter.    An example of this 
report is shown below.    The name of the user concerned is displayed at the top of the first column.

"John" "Micropauses taken" "Micropauses ignored" "Keystroke total" "Mouse 
Clicks" "Usage Time"

"1/3/98" 40 13 20,345 1,122 5:34

"2/3/98" 34 5 13,034 834 4:21

"3/3/98" 30 7 25,543 1,533 4:06

"4/3/98" 45 9 22,342 1,234 4:34

"5/3/98" 25 12 18,123 942 3:12

Note that this format is primarily intended for importing into other packages, such as Excel, Word, and 
Access.




